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Sexual Differentiation at the Beginning

Sexual Diff. at the Beginning (cont.)

» Differences emerge in the womb
» Rates of conception
Vulnerability
Responsiveness to environmental stimuli
Size and morphology
Brain development

v v v v v

Birth experiences
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Contents lists available at ScienceDirec

Developmental Cognitive Neuroscience

journal homepage: www . elsevier

Sex differences in functional connectivity during fetal brain development

M.D. Wheelock”, J.L. Hect”, E. Hernandez-Andrade™, S.S. Hassan™“", R. Romero
A.T. Eggebrecht" ", M.E. Thomason

» fMRI study of 118 children in the womb (70 male, 48 female, 26-40
weeks)

» “These observations confirm that sexual dimorphism in functional
brain systems emerges during human gestation.”

In childhood...

» Differences in sensation begin to emerge
» Olfaction
» Hearing
» Vision
» Infant girls prefer to look at faces than objects

» Toy preferences emerge...

7
In childhood... Sex Differences in Childh
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Nurture and “Gender Identity”

» Family Influences
» Parents expectations, hopes, fears, etc.
» Parents treat boys and girls differently
» Parents “teach” gender to children
» Attachment

» Peer Influences

» Importance of acceptance with same-sex peers

Development of “"Gender Identity”

Intemational joumal of

Behavioral Development

2019, Vol. 43(4) 289-304

© The Author(s) 2019

Artide reuse guidelines:
sagepub.com/journals-permissions
DO 10.1177/0165025418811129
journals.sagepub.com/homeljbd
David G. Perry,' Rachel E. Pauletti,” and Patrick ). Cooper? @SAGE

Gender identity in childhood: A review
of the literature

» They highlight eight dimensions of “gender identity”

11

12




1/14/2022

Eight Dimensions of Gender Identity Eight Dimensions of Gender Identity
» Gender self-categorization » Gender self-categorization
» Felt same-gender typicality » Felt same-gender typicality
» Felt other-gender typicality » Felt other-gender typicality
» Gender contentedeness » Gender contentedeness
» Felt pressure for gender differentiation » Felt pressure for gender differentiation
» Intergroup bias » Intergroup bias
» Gender centrality » Gender centrality
» Gender frustration Perry et al, 2019 » Gender frustration Perry et al, 2019
14
In adolescence... Sex Differences In Adulthood
» Puberty . Body .
» Sexual maturation of the body )
» Erotic attraction emerges based on feeling “different” - Brain
> Cognition
» Psychological tasks of adolescence )
» Identity, Community, Mission - Emotion
» Self-Image
» Differential mental health issues
16

Sex Differences In Adulthood

OXFORD

ORIGINAL ARTICLE > Interpersonal relations .
Sex Differences in the Adult Human Brain: Evidence
from 5216 UK Biobank Participants > Occupational choice

Stuart ). Ritchie'?, Simon R. Cox'2, Xueyi Shen @3, Michael V. Lombardo*5,
Lianne M. Reus®, Clara Alloza3, Mathew A. Harris?3?, Helen L. Alderson’,

Stuart Hunter®, Emma Neilson?, David C.M. Liewald!2, Bonnie Auyeung!, L. )
Heather C. Whalley?, Stephen M. Lawrie?, Catharine R. Gale2?, > Religiosity
Mark E. Bastin?1%.11, Andrew M. McIntosh?? and lan J. Deary'-?

» Morality

> Among various differences, results “showed stronger connectivity for males in e Sexua“ty

unimodal sensorimotor cortices, and stronger connectivity for females in the
default mode network.”
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What is the essence &
purpose of femaleness?

What is the essence &
purpose of maleness?
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Image of God:
Transcendent & Immanent

Understanding Gender Dysphoria
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Gender Identity
Di er and
1al Problems

MARK A. YARHOUSI
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Sexuality and Gender
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What is Gender Dysphoria?

» The experience of “clinically significant distress
or impairment” associated with the perceived
incongruence between one’s psychological /
emotional “gender identity” and one’s biological
sex.

» Formerly known as “Gender Identity Disorder”

» With or without an underlying DSD (i.e., intersex
condition)

What is the experience of GD like?
» Preference for toys, games, activities, and types
of play associated with other sex

» Rejection of typically masculine / feminine toys,
games, activities, types of play

» Preference for cross-gender roles in make-
believe

» Preference for playmates of other sex
» Preference for cross-dressing

25 26
What is the experience of GD like? What is the experience of GD like?
» Belief one has typical qualities of other sex » Subtypes
» Desire to be treated as the other sex » Early vs. Late Onset
» Desire to be other sex or insistence that one is » Blanchard’s typology:
» Dislike of one’s sexual anatomy > FtM
» Desire to get rid of one’s primary / secondary
o > MtF
sex characteristics
) Essentially, » Androphilic
» I am not at home with my body and sexuality » Autogynephylic
27 28
What is the experience of GD like? What is the experience of GD like?
» Associated with tremendous psychological » Zucker (2019) offers three explanations for all
suffering (comorbidity) the comorbidity:

» Children: anxiety, depression, disruptive / » “gender dysphoria has emerged as secondary to another,
impulsive behavior problems, autism spectrum more ‘primary’ mental health diagnosis”
disorder » “gender dysphoria is inherently distressing”

4 Ad‘?'esc‘?”ts & Adults: anxiety, mood disorders, » social ostracism, rejection, minority stress, etc.
eating disorders, substance abuse, self-harm, and
suicide

29 30
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How common is gender dysphoria?

» DSM-5:
» .005 to .014% of adult males
» .002 to .003% of adult females
» Other research:
» 1in 10-13,000 males
» 1in 20-34,000 females
» If you let people self-select “transgender”:
» Rates are higher
» Recent study of HS: 1-2% (Johns et al., 2019)
» Historically, males are 3-5x more likely, but...
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Kaltila-Heino et ol. Child and Adolescent Paychiatry and Titation: Litman L (2018) Rapid-onset gender
Mental Health (2015) 99 m g‘:lczﬁ :&O&Lﬁmzl HeALTH dysphoria in adolescents and young adults: A
DOI 10.1186/513034-015-0042-y [y ) i study of parental reports. PLoS ONE 13(8).
@ PLOS ‘ ONE 20202330. https://doi.org/10.1371/journal
N 0ne.0202330
RESEARCH Open Access RESEARCH ARTICLE

Two years of gender identity service for minors:
overrepresentation of natal girls with severe
problems in adolescent development
» All cases referred to two specialty gender clinics in
Finland between 2011-2013 (n=47)

» Surprising increase in adolescent females with a history of
psychosocial problems

Rapid-onset gender dysphoria in adolescents
and young adults: A study of parental reports

Lisa Littman*

Department of Behavioral and Social Sciences, Brown University School of Public Health, Providence. Rhode
Island, United States of America

» Surveyed 256 parents of ROGD young people

» Identified cluster outbreaks and possibility of social
contagion

33 34
How persistent is gender dysphoria? What causes gender dysphoria?
» The majority of early onset cases remit before » Biology
adulthood.
» DSM: » Genes?
» 2-30% of GD males persist
» 12-50% of GD females persist » Hormones?
» WPATH: 6-27% of GD children persist to adulthood » Brain structures?
» If GD lasts through puberty or is late-onset, it
tends to be more persistent
» If transitioning and/or puberty suppression
occurs, then persistence goes WAY up
35 36
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What causes gender dysphoria?

» Psychosocial factors (e.g., Zucker & Bradley, 1991)
» Parental psychopathology
» Family dynamics
» Adverse childhood experiences
» Peer issues

» Cultural / social pressures

What causes gender dysphoria?

“Psychosocial factors also have a role to play in
the etiology of gender-variant identities. There is
evidence that poor or absent parental
relationship, childhood abuse, and parental
encouragement of gender-variance are more
common amongst gender-variant populations”
(Veale et al., 2010, p. 364).

37

38
‘ 1 ORIGINAL RESEARCH
What about Attachment? < frontiers  Februan
> Recall Perry et al.’s Dimensions of Gender Identity Attachment Patterns and Complex
> At least three of those dimensions are scientifically linked Traumain a Sample of Adults
with childhood attachment experiences: - - -
Diagnosed with Gender Dysphoria
» Felt same-gender typicality
R Guido Giovanardi’*, Roberto Vitelli?, Carola Maggiora Vergano', Alexandro Fortunato’,
> Gender contentedeness Luca Chianura?, Vittorio Lingiardi* and Anna Maria Speranza’
> Felt pressure for gender differentiation » 95 Gender Dysphoric adults
> These play a major role in whether someone will come to > 123 non-GD adults in a control group
acceptance of their bodily sex » Adult Attachment Interview
» Complex Trauma Questionnaire
39 40
What about Attachment? What about Attachment?
» Giovanardi et al. (2018): Attachment results » Giovanardi et al. (2018)
>
Gender Dysphoria | Control Group Complex Trauma results
> Four or more developmental traumas?
Secure 27% 61% > Control group = 7%
Insecure 73% 399, » Gender dysphoria group = 56%
» Gender dysphoric group scored similarly to a
Disorganized 46% 13% clinical reference group consisting of patients with
dissociative and/or personality disorders
41
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Treatment Options

Catholic Moral Principles

» Persons confused about sexual identity must be
accepted with respect, compassion, and sensitivity

» We must honor and respect our bodies

43 44
Vatican II: Gaudium et spes, no. 14 Catholic Moral Principles
. » Persons confused about sexual identity must be
> $E?ggghhn’l‘ll?sd§o?jfiIt;/ogg/n‘?:gsist?grlll hn;agnall:f'lgrnset.o accepted with respect, compassion, and sensitivity
himself the elements of the material world; thus > We must honor and respect our bodies
they reach their crown through him, and through » All are called to acknowledge and accept the sexual
him raise their voice in free praise of the Creator. identity revealed by the body
For this reason man is not allowed to despise his
bodily life, rather he is obliged to regard his body
as good and honorable since God has created it
and will raise it up on the last day.
45 46
Catechism of the Catholic Church Catholic Moral Principles
" . » Persons confused about sexual identity must be
> _S(te;](uallt}; afffe(r:]t_s i” g\spec;s of Ithf" human person accepted with respect, compassion, and sensitivity
I the unity of his body and soul... » We must honor and respect our bodies
» "Everyone man and W_O"na'?‘ Sl;lou'd acknowledge » All are called to acknowledge and accept the sexual
and accept his sexual identity... identity revealed by the body
Nos. 2332-2333 » Publically simulating the other sex is dishonest /
deceptive and potentially scandalous
» While medicine can be used to treat physical illness, it
must never be used to poison or mutilate a healthy
body system
47 48
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Catholic Moral Principles (cont.)

» Intersex conditions (DSDs): we should favor the
least invasive approach possible that resolves the
difficulty in line with the dominant sex expressed
in the person’s reproductive anatomy, if possible

» In cases of gender dysphoria without an
underlying DSD, we should seek treatments to
help the person accept the natural sexual identity
revealed by the body

Catholic Moral Principles (cont.)

> What about the name issue?

> 2158 God calls each one by name. Everyone's name is
sacred. The name is the icon of the person. It demands
respect as a sign of the dignity of the one who bears it.

> 2159 The name one receives is a name for eternity....

49 50
Morally Acceptable Tx Options Morally Acceptable Tx Options
» For Children: » For Adolescents and Adults:
» Psychosocial Tx to promote acceptance of sex » Tx to resolve GD in line with birth sex
revealed by the bod . .
4 4 » Tx for comorbidities, underlying factors
» Examples: ) ) )
> Zucker (2008); Zucker et al. (2012) >Tx without fixed endpoint
> Meyer-Bahlburg (2002) » Exploratory work regarding identity, body image,
family relations, sexuality, etc.
» Watchful Waiting
> Remember, about 85% of cases desist on their own
51 52
Morally Acceptable Tx Options Morally Acceptable Tx Options
> For Adolescents and Adults: » For Adolescents and Adults:
> Zucker (2019): » D’Angelo et al (2020):

» “One could consider recommending exploratory e “We bellevg that_ ex’plora‘tory psyf:holtherapy that is )
psychosocial treatment without social transition and Pe't:er ?fﬂm;aftlon ”nor conver5||on _str;ogIg be Ehetflrﬁt-
hormonal suppression, particularly if the case ine treatment for all young peopie Wi ), potentially
formulation is that the,gender dysphoria has emerged reducing the need for invasive and irreversible medical
in the context of other psychosocial factors or as a procedures. This is especially critical now, when we are
result of other mental health issues.” witnessing an exponential rise in the incidence of young

) people with GD who have diverse and complex mental
health presentations and require careful assessment and
treatment planning.”

53 54
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Morally Problematic Tx Options
» The Affirmative Approach (the “Dutch Protocol”)

> Social Transitioning

» Puberty Suppression Growing Pains
Problems with Puberty Suppression

» Cross-sex Hormones in Treating Gender Dysphoria

Paul W Hruz, Lawrence 8. Mayer, and Paul R. McHugh

New Atlantis, 52: 3-36.

> Plastic Surgery

» Studies show that most people report subjective
satisfaction in the short-term, but...

OPEN & ACCESS Freely available online = PLoS one

Long-Term Follow-Up of Transsexual Persons
Undergoing Sex Reassignment Surgery: Cohort Study in
Sweden

Cecilia Dhejne’, Paul Lichtenstein®, Marcus Boman?, Anna L. V. Joh 12, Niklas Langstrom®?, Mikael
Landén'24:

1 Department of Clinkcal Neuroscience, Division of Psychiatry, Karolinska Institutet, Stockholm, Sweden, 2 Department of Medical Epidemiology and Biostatistics,
Karolinska Institutet, Stockholm, Sweden, 3 Centre for Viokence Prevention, Karolinska Institutet, Stockholm, Sweden, 4institute of Neurosdence and Physiology, The
Sahigrenska Academy at Gothenburg University, Gothenburg, Sweden

» N=324
» 3x higher psych hospitalization
» 19.1x higher rate of suicide

55 56
Any Cause of Death
Matched on sex at birth
Male controls (]
0.75 Female controls foEEees
‘‘‘‘ Male to female
| — Fomalo to mal | » Walt Heyer
Y Q}’)e e Foboton e ) » http://WaltHeyer.com & www.sexchangeregret.com
57 58
Tx Options dwindling... Minnesota Conversion Therapy Bans
> Pressure to ban Tx to bring noncongruent “gender > At least these municipalities currently have
identity” back in line with birth sex. “Conversion Therapy” bans:
» WPATH: “Treatment aimed at trying to change a > Bloomington > Robbinsdale
person’s gender identity and expression to become > Duluth > St. Paul
more congruent with sex assigned at birth... is no ) .
longer considered ethical.” » Minneapolis » West St. Paul
> At least, 20 states and 99 municipalities have > Red Wing > Winona
passed legal bans for Tx with minors aimed at
aligning with birth sex
59 60
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Duluth’s Conversion Therapy Ban

» 34-43: “Prohibition of Conversion Therapy”

> Bans provision of “conversion therapy” with minors and
threatens monetary fines

> “Conversion therapy is an ineffective and unsafe practice
based on the discredited premise that a person’s gender
identity or sexual orientation is a mental disorder that
can be cured or corrected.”

> “Conversion therapy means any practice or treatment by
a provider that seeks to change an individual’s sexual
orientation or gender identity...”

Duluth’s Conversion Therapy Ban (cont.)

» 34-43: “Prohibition of Conversion Therapy”

» This does NOT include “counseling that provides support
and assistance to a person undergoing gender transition,
or counseling that provides acceptance, support and
understanding of a person or facilitates a person’s coping,

social support, identity exploration, development,
including sexual orientation and gender identity, and
neutral interventions to prevent or address unlawful
conduct or unsafe sexual practices if such counseling is
not conducted with the goal of changing the person’s
sexual orientation or gender identity.”

61 62
Minnesota Conversion Therapy Bans (cont.)
» Gov. Walz Exec. Order 21-25 “Protecting
Minnesotans from ‘Conversion Therapy””
» Not a law, but a rule applying to state agencies
TovE e ppying fo state 29 Pastoral Response
» Limiting ability of providers to get reimbursement for
“conversion therapy”
» Encourages licensing boards to enact bans on
conversion therapy
» A sign of things to come?
63 64
General Pastoral Principles General Pastoral Principles
» Joyfully announce the Gospel > Speak the truth in love:
. L > “departure from the Church's teaching, or silence
> Always affirm the dignity of the person about it, in an effort to provide pastoral care is
» Welcome and accept people as they are neither caring nor pastoral. Only what is true can
> Be careful with language / terminology ultimately be pastoral.” (CDF, 1986, no. 15).
. . » Uphold the truth of being created male and female and
> Better t(_) say “people who experience gender called to love
dysphoria” rather than trans person, etc. > Men are called and equipped to love as fathers
» Women are called and equipped to love as mothers
65 66
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General Pastoral Principles
» Ministers must:

» Teach and model the truth regarding the nature of
the human person, male and female
»Theology of the Body

> Live our own vocations as men and women,
fathers and mothers faithfully and joyfully

» Encourage others to accept the sexual identity
revealed in their body as a gift and a call from

General Pastoral Principles

» Ministers must not:

» Teach, promote, or encourage an understanding of the
human person contrary to the teachings of the
Catholic Church

» Advocate or celebrate relationships or conduct,
including transgender attitudes, that conflict with
Catholic teaching

> Participate in or promote the denial of students’
biological sex or transitioning to different sex

God
67 68
General Pastoral Principles When a Youth says he/she is trans...
» Ministers must not: » Don't Panic!
» Sponsor, facilitate or host organizations, events or » Remember, with God all things are possible
activities that would promote views of gender that N ) ) )
conflict with Catholic teaching, either on or off > He has a plan for this child of His
campus, or through social media > There is no wound that He can’t heal, no sin that He
» Put vulnerable youth in harms way by exposing them can't forgive.
to gender ideology, cross-dressing or scandalous » It is not your job to “fix" it
behavior, or by allowing access to opposite sex » Seek consultation: Pastor, other youth ministers,
bathrooms / locker rooms :
Archdiocese
» Shame youth for having gender dysphoria
69 70
When a Youth says he/she is trans... When a Youth says he/she is trans...
» Take the “Long View” » Show Them the Love of Christ
> Sm%T: wounds take a lifetime to heal and some take > Spend time with them building a relationship
> A lot can happen in life and God can bring good out of > Show them that you care
any circumstances. » Affirm the goodness of the person and their desire
» His love and mercy are more powerful than our for love, happiness
mistakes > Help them encounter God with you
> Entrust this person to God > Pray with them and for them
71 72
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When a Youth says he/she is trans...

> Listen, listen, listen

» These kids have a story to tell and they need
caring adults to listen

» Show genuine interest in their experiences, their
feelings, their desires / hopes / fears

» Show empathy
» Imagine what their experiences have been like
> Reflect back to them the key elements

When a Youth says he/she is trans...

> If rapport is good, ask open-ended questions to
invite deeper exploration

> If possible, help them connect the dots in their
story

» Help them give words to their experiences and
see the connections between them

» Listen for other signs of psychological distress and
even suicidality

73 74
When a Youth says he/she is trans... When a Youth says he/she is trans...
» Affirm young person’s identity as child of God » Gently teach when there is an opening
» Ensure all children treated with compassion, > God creates male or female and provides a plan for
sensitivity and respect life, a calling to love as a man or woman
» Distinguish between those who are struggling > The body reveals the person
with it and those who “present” it publicly as an > His body and sexuality are integral to his identity and
identity, expecting to be recognized and vocation
accommodated > Help him re-evaluate his assumptions in light of this
75 76
When a Youth says he/she is trans... When a Youth says he/she is trans...
» Gently teach when there is an opening » Gently teach when there is an opening
> Help them to see that the person is more than his » Lovingly try to dissuade them from actions that
experiences ultimately will not contribute to their own good
» Culture: you feel trans > therefore you are trans and may cause long-term harm
» Church: the body reveals who you are even if you » Help them, support them in making good choices
feel different > I am a man who experiences in accord to their true, authentic good
dysphoria / distress / confusion about my sexual
identity
77 78
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When a Youth says he/she is trans...

» Explore and expand their understanding of male and
female

» Breakdown stereotypes while also validating how they
may have come to their views

» Help them find same-sex role models to look up to

» Help them make friendships with healthy same-sex
peers

» Opportunities and activities where they can experience
acceptance and belonging

When a Youth says he/she is trans...

» Work with parents to understand the situation,
clarify what best serves the true good of the
youth and the good of the group / school, etc.

» Try to build alliance around pursuing these goods

> Goal: acceptance of one’s body and the sexuality it
reveals

» Make good referrals (see resource sheet)

» Pastor, psychologist, medical doctor, support groups,
books, websites

79

80

When a Youth says he/she is trans...

» If they want you to use a different name, seek a
reasonable compromise that doesn’t go too far

» Set clear boundaries around gender-bending
behavior.

> Patiently, help them to see the difference between
loving the person and approving one’s actions

When a Youth says he/she is trans...

» If student and/or family insists on publically
embracing a “trans” identity and/or allowing
transitioning...

» There is not an alignment of goals, values

» Out of love for them and for others who would be
impacted, we may need to refuse participation

81

82

Cautions

A4

Don’t say or do anything that allows them to justify the
idea that God or the Church hates / rejects them

Don’t lecture them

Don’t invalidate their experience

Don’t stereotype them

Don’t get into arguments about causes

YV V V V V

Don’t bog them down with overly technical theological or
moral language

A4

Don’t implicitly or explicitly endorse things that are not
in accord with the true good of the person

Discussion

83

84
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Resources

> See the resource sheet for an extensive list of
websites, documents, books, support groups and
more.

» In particular..

ABOUT US THEBASICS PARENTS SCHOOLS PARIsHES  [JCONTACHN

C!“‘ ";‘_

The Person and Identity Project provides formation, resources, and pastoral guidance on issues of faith,

“gender” and sexual identity

85

One more resource....

ROOTED: Theology of the Body
K-12 Curriculum

Age-appropriate teaching inspired by
the masterwork of
Pope St. John Paul Il.

Ruah#Woods

www.RuahWoodsPress.com
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